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ELA  Eesti Lennuakadeemia 

ESTERM Eesti Keele Instituudi mitmekeelne terminibaas 
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NATO North Atlantic Treaty Organisation, Põhja-Atlandi Lepingu 

Organisatsioon  

PDF  Portable Document Format, teisaldatav dokumendiformaat 
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USA   United States of America, Ameerika Ühendriigid  

ÜRO  Ühinenud Rahvaste Organisatsioon 
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SISSEJUHATUS 

Üliõpilaste kirjalikud tööd kajastavad omandatud teadmisi ja oskusi praktiliste ja 

teoreetiliste küsimuste käsitlemisel. Vormistuslike nõuete järgimine kirjalikes töödes on 

sama oluline kui töö sisuline pool. 

Eesti Lennuakadeemia (ELA) kirjalike tööde vormistamise juhend on koostatud 

üliõpilaste kirjalike tööde struktuuri  ja vormistamise ühtlustamiseks.  

Antud juhendi vormistamisel on võetud aluseks senini kehtinud ELA „Lõputööde 

vormistamise juhend“ (2009), Tartu Ülikooli (TÜ) majandusteaduskonna kirjalike tööde 

juhend ning lisamaterjalid kirjalike tööde vormistamisest, viitamisest ja teadusteksti 

koostamisest.   
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1 VORMISTAMISE ÜLDNÕUDED 

Kirjalikud tööd vormistatakse arvutil formaadis A4,  trükitakse ühepoolselt A4-suurusele 

valgele paberile.  

Lehe äärised (Layout→Margins→Custom Margins..):  

 üleval (Top) 3 cm, 

 all (Bottom) 3 cm, 

 vasakul (Left) 4 cm, 

 paremal (Right) 2 cm.  

Kõik töö leheküljed tuleb nummerdada ühtsesse süsteemi ja lehekülje number paigutada 

lehe alla keskele. Tiitelleht võetakse nummerdamisel arvesse, kuid leheküljenumbrit 

tiitellehele ei märgita (Insert → Page Numbers).  

Lühikeste kirjalike tööde (1-3 lk) puhul ei vormistata tiitellehte. Töö pealkirjastamiseks 

kasutatakse teise taseme pealkirja (Heading 2), mis joondatakse vasakule. Dokumendi 

päise paremasse serva lisatakse üliõpilase nimi, kursus, eriala ning esitamise kuupäev (vt 

Lisa 4).  

1.1 Pealkirjad ja sisukord 

Töö iseseisvaid põhiosi (sisukord, sissejuhatus, uus peatükk, kokkuvõte, kirjanduse 

loetelu, resümee) alustada uuelt leheküljelt (Insert→Page Break), jättes ette 84 punkti 

suurune vahemik (Layout→Spacing: Before: 84 pt).  

Pealkirjades lühendeid ei kasutata ja pealkirja lõppu punkti ei panda. Pealkirjad 

joondatakse lehe vasakusse serva (tekstipaigutus Align Left). Pealkirja ja järgneva (või 

samal leheküljel eelneva) teksti vahe on 12 punkti.  

Pealkirjade vormistamisel kasutatakse automaatset pealkirja vormingute süsteemi (vt 

näide 1), mis on hiljem vajalik sisukorra automaatseks vormistamiseks. 
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Näide 1:  

1. PÕHIOSA PEALKIRI (Heading 1, Times New Roman, 16 punkti, rasvane 

(Bold), läbiv suur täht) 

1.1 Teise taseme pealkiri (Heading 2, Times New Roman, 14 punkti, rasvane 

(Bold))  

1.1.1 Kolmanda taseme pealkiri (Heading 3, Times New Roman, 12 punkti, rasvane 

(Bold)) 

Sisukord lisatakse automaatselt (References→Table of Contents→automaattabel) ning 

tuleb enne printimist ja/või esitamist uuendada (Update Field).  

1.2 Põhiosa ja tekst 

Tekst kirjutatakse kirjastiilis Times New Roman, kirjasuurusega 12 punkti ja reavahega 

1,5.  Töö tekst jaotada lõikudeks, kasutades plokkstiili, st eraldades tekstilõigud laiema 

vahemikuga (12 punkti ehk üks tähekõrgus: Page Layout → Spacing: Before 12 pt). 

Teksti trükkimisel vajutada klahvi <Enter> mitte iga rea lõpus, vaid ainult lõigu 

lõpetamisel. Taandridu lõikude tähistamiseks ei kasutata.  

Tekst joondada mõlema serva järgi (tekstipaigutus Justify). Tekstis tekkivate 

põhjendamatute lünkade (nn aukude) korral kasutada poolitamist.  (klahvikombinatsioon 

<Ctrl> + <−>). 

1.3 Stiil ja keel 

Oluline on töö keeleline ja stiililine korrektsus. Keelekasutus peab olema rangelt 

teaduslik. Hoiduda tuleks paljusõnalisusest, vältida sõnakordusi. Kõneviis ja -vorm, 

milles töö kirjutatakse, peab olema ühtne kogu töö ulatuses. Autor ei tohiks end asetada 

ühe poole positsioonile. “Mina” ja “meie” vormi (näiteks “meie uurisime”, “ma 

analüüsisin”) sagedase kasutamise asemel tuleb kasutada umbisikulist vormi (näiteks 

“töös käsitletakse, analüüsitakse, uuritakse, hinnatakse” või “on käsitletud, analüüsitud 
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jne.”). Eelistatav on kindla kõneviisi kasutamine, sest tingiva kõne valdav kasutamine 

võib jätta mulje, et autor ei ole oma seisukohtade õigsuses kuigi veendunud.  

Korrektsete eestikeelsete terminite leidmisel tuleb kasutada Eesti Keele Instituudi 

mitmekeelset terminibaasi ESTERM, mis sisaldab peamiselt Euroopa Liidu ja Eesti 

Vabariigi õigusaktide termineid. Terminibaas koondab üle 50 valdkonna terminoloogiat 

(sh lennundus) ning on kättesaadav aadressil http://termin.eki.ee/esterm/. Eesti Keele 

Instituudi terminoloogid täiendavad ja ajakohastavad Estermi pidevalt. (Esterm, 2017) 

1.4 Loetelud 

Loetelu igal tasandil peab olema vähemalt kaks alapunkti. Kogu töö ulatuses tuleks 

kasutada ühtset loetelude esitust ning vältida paljude erinevate stiilide kasutamist. 

Loeteluga pole sobiv peatükki lõpetada või alustada. Loetelu koostades tuleb alati 

kaaluda, kuidas liita loetelu loomulikul viisil ümbritseva tekstiga. Loetelud tähistatakse 

numbritega, väiketähtedega või täpploendiga.  Loetelude trükkimisel on reavahe 1,5 ja 

lõiguvahe 0. Vältida tuleb loeteludega liialdamist. 

Kui loetelu koosneb üksikutest sõnadest või lühikestest fraasidest, siis loetelu punktid 

eraldatakse komaga (vt näide 2).  

Näide 2: 

Vastuvõtunõuded: 

 keskharidus, 

 võõrkeele riigieksam, 

 matemaatika või füüsika riigieksam, 

 psühholoogiline sobivus, 

 tervislik sobivus,  

 kriminaalkaristuse puudumine. 

Kui kasvõi üks loetelu punktidest sisaldab koma(sid) või muid kirjavahemärke, tuleb 

eraldusmärgina kasutada semikoolonit. Alustatakse väikese tähega ning sel juhul 

tähistatakse järjekorda  ümarsulgudega varustatud numbrite või tähtedega (vt näide 3).  

  

http://termin.eki.ee/esterm/
http://termin.eki.ee/esterm/
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Näide 3: 

Kui inflatsiooni põhjuseks enne rahareformi oli valdavalt liigne ringluses olev rublade 

mass, siis peale rahareformi on peamised põhjused järgmised: 

1) reaalse vahetuskursi kallinemine inflatsiooni abil, mis tuleneb krooni väärtuse 

allahindamisest rahareformi käigus; 

2) produktiivsuse ja (oodatavate) tulude kasvuga kaasnev majanduse tasakaalu 

tagava reaalse vahetuskursi kallinemine; 

3) suhteline hindade muutumine, s.h. suletud sektori hindade tõus. 

Kui kasvõi üks loetelu punktidest koosneb kahest või enamast lausest, siis asendatakse 

sulg järjekorranumbri järel punktiga. Kui mõni loetelu punkt sisaldab omakorda loetelu, 

siis tähistatakse üldisema loetelu punktide järjekorda tingimata numbritega, alluva loetelu 

punkte aga tähtedega (vt näide 4). 

Näide 4: 

Teooria all mõistetakse definitsioonide, eelduste ja hüpoteeside süsteemi. Teooriaid võib 

jaotada järgmiselt (Üliõpilaste kirjalikud tööd, 2011): 

1. Klassifitseerivad teooriad selgitavad majanduslikke realiteete mõistete 

defineerimise kaudu. 

2. Nomoloogilised teooriad on suunatud protsesside sisemiste seaduspärasuste 

avastamisele. 

3. Otsustusteooriad käsitlevad teatud inimkäitumise viise. Sealjuures võib neid 

jagada: 

a) deskriptiivseteks, 

b) preskriptiivseteks. 

1.5 Lühendid 

Soovitatav on kasutada üldlevinud lühendeid, mille täisnime ei ole üldjuhul tavaks pruukida 

(näiteks: ÜRO, USA, NATO jt). Ettevõtete ja asutuste pikki nimesid on samuti soovitatav 

nende korduvkasutamise korral lühendada, enne lühendi loomist tuleks see lahti kirjutada. 

Näiteks: Lennuliiklusteeninduse Aktsiaselts (LLT AS). Juhul kui lühendite, sümbolite, 
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laensõnade või mõistete maht on üle kümne, tuleks need kõik seletustega esitada eraldi 

loeteluna enne sissejuhatust (vt Kasutatud lühendid). (Tallinna Tehnikakõrgkooli 

kirjalike tööde vormistamise juhend, 2016, lk 10) 

1.6 Tabelid 

Kõik töös esinevad tabelid nummerdatakse araabia numbritega kas läbivalt kogu töö 

ulatuses (mida soovitatakse kuni 10 tabeli korral) või suurema hulga tabelite korral 

üksikute peatükkide ulatuses. Näiteks “Tabel 1.” või “Tabel 3.4”, kusjuures viimane 

tähendab kolmanda peatüki neljandat tabelit. Sama moodust on soovitatav kasutada ka 

jooniste ja valemite tähistamisel. 

Tabeli pealkiri joondada vasakule. Tabeli pealkirja ette kirjutada sõna “Tabel” koos 

numbriga rasvases (Bold) kirjas. Pärast tühikut järgneb tabeli pealkiri tavalises kirjas 

kirjasuurusega 12 punkti reavahega 1,5. Pealkirja ja tabeli vahele jätta 12-punktine vahe. 

Tekst ja arvud tabelis tuleb esitada kirjasuurusega 11 punkti reavahega 1,0 (Single) ja 

tabel tuleb paigutada lehe keskele (Center). 

Tabelites esitatud andmed tuleb siduda töö tekstiga (näiteks „Alljärgnev tabel 3 

iseloomustab...“ või „vt. tabel 8“). Tabelist peavad selguma kasutatud andmete allikad.  

Näide 4: 

Tabel 1. Keskmine brutokuupalk aastatel 2011 – 2016, eurodes (Statistikaamet, 2017) 

 2011 2012 2013 2014 2015 2016 

I kvartal 792 847 900 966 1 010 1 091 

II kvartal 857 900 976 1 023 1 082 1 163 

III kvartal 809 855 930 977 1 045 1 119 

IV kvartal 865 916 986 1 039 1 105 1 182 

1.7 Valemid  

Valemid ja nendes kasutatud sümbolid järgnevas tekstis kirjutatakse kaldkirjas (Italic) 

kirjasuurusega 12 punkti. Valemite vormistamisel tuleb kasutada valemiredaktorit (Insert 

→ Equation).  
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Kui töös on mitu valemit, tuleb need nummerdada. Valemi number paigutatakse valemiga 

samale reale (soovitatavalt vasakule) sulgudesse. Valemites ei tooda mõõtühikuid, need 

esitatakse valemites kasutatud sümbolite seletustes. Valemi sümbolite seletus algab 

sõnaga “kus” (ilma järgneva koolonita) ning seletused kirjutatakse ülevaatlikkuse mõttes 

üksteise alla. Igas uues valemis selgitatakse ainult esmakordselt esinevaid tähistusi. 

Näide 5: 

Lainepikkus avaldub järgmisest valemist (Stacey, 2008): 

(1)     λ=
C

f
 ,  

kus   λ – lainepikkus [m],  

 c – valguskiirus [m/s2],  

 f – sagedus [Hz]. 

1.8 Joonised 

Joonisteks on illustratsioonid, diagrammid, graafikud, kaardid, joonistused, skeemid või 

fotod. Igal joonisel peab olema allkiri. Kõik joonised nummerdatakse analoogiliselt 

tabelitega. Joonise järjekorranumber kirjutatakse allkirja ette rasvases (Bold) kirjas ja 

eraldatakse sellest punktiga (nt Joonis 1. Üldised reeglid viitamisel (Harris, 2001) ). 

Joonisele kantavad tähised, arvud ja sõnaline tekst tuleb trükkida suurusega 11 punkti. 

Igale joonisele tuleb töö tekstis viidata. Joonis paikneb tekstis sobivas kohas pärast viidet. 

Analoogiliselt tabeliga tuleb joonise juures näidata vastav allikas või märkida, et joonis 

on autori poolt koostatud. 
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Näide 6: 

 

Joonis 1. Üldised reeglid viitamisel (Harris, 2001) 

1.9 Lisad 

Lisadesse tuleb paigutada need arvandmed ja muud materjalid, mis on vajalikud 

probleemi käsitlemiseks, kuid mille esitamiseks tekstis pole otsest vajadust või kui on 

tegemist väga mahuka materjaliga (uurimuse tugimaterjalid, ankeedid, tabelid jne). 

Lisad nummerdatakse neile viitamise järjekorras araabia numbritega, märkides vasakusse 

serva rasvases kirjas, mitmes lisa on (nt „Lisa 1. Tiitellehe näidis“) ning sellele järgneb 

lisa pealkiri. Punkti pealkirja lõppu ei panda. Iga lisa peab algama uuelt leheküljelt. Kui 

lisas olev tekst, pilt, tabel vms ei ole autori oma, tuleb selle päritolu näidata täpse 

allikaviitega. 

Lisade pealkirjade loetelu ei esitata sisukorras. Esimese lisa ette tuleb paigutada 

lehtpealkirjaga „Lisad“ ja esitada sellel lisade pealkirjade loetelu (vt Lisad).  

  

Sisend Kas mõtlesid selle ise välja? 

Ei Jah Ära viita 

Kas see on tavateadmine? 

Ei Jah Ära viita 

VIITA! 
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2 VIITAMINE 

Lähtematerjalina kasutatakse sageli seisukohti ja andmeid, mis põhinevad varem 

avaldatule või teadaolevale. Vastavalt autoriõiguse seadusele on kirjalikes töödes teiste 

autorite kogutud andmete, seisukohtade jms viitamine kohustuslik.. (Viitamine, 2013) 

Kasutatud kirjanduse loetelu kirjaliku töö lõpus peab sisaldama kõiki allikaid, millele on 

töös viidatud ja vastupidi – igale loetelus leiduvale allikale peab töös leiduma viide. 

Viitamissüsteeme on erinevaid (autor ja aasta, numbriline), kuid ühes töös tuleb kasutada 

läbivalt üht süsteemi. 

Levinumad stiilid on 

 APA Style (nime-aasta). Tutorial Monash university , 

 IEEE Style (numbriline). Tutorial Monash University. (TTÜ Raamatukogu, 

2017) 

Refereering on teise autori seisukoha ümbersõnastus. Tsitaat on teise autori tekstist 

sõnasõnaline väljavõte, mis tuleb esitada jutumärkides. Kui viide käib ainult ühe lause 

kohta, pannakse viide enne lause lõpumärki. Kui viidatakse terve lõigu kohta, pannakse viide 

pärast lause lõppu. (Tallinna Tehnikakõrgkooli kirjalike tööde vormistamise juhend, 2016, lk 

9) 

Viitekirjete haldamiseks on MS Wordis võimalik kasutada tööriistu mis asuvad References – 

Citations & Bibliography. Viite lisamiseks Insert Citation¸ viitekirjete haldamiseks Manage 

Source, kasutatud kirjanduse loetelu loomiseks Bibliography. 

  

http://www.apastyle.org/learn/faqs/index.aspx
http://guides.lib.monash.edu/citing-referencing/apa
http://library.queensu.ca/research/guide/ieee-citation-style
http://guides.lib.monash.edu/citing-referencing/ieee


 
14 

 

3 LÕPUTÖÖ  

Lõputöö on üliõpilase poolt juhendaja suunamisel koostatav aktuaalset lennundusalast 

probleemi käsitlev ja lahendusi pakkuvrakendusliku suunitlusega iseseisev uurimus. 

Lõputöö koostatakse, kui õppekavas, millel üliõpilane õpib, on lõputöö koostamine 

õppekava läbimise eeldusena ette nähtud. (ELA lõputöödega...., 2016)  

Eesti Lennuakadeemia lõputöödega seonduva tegevuse korraldamise eeskirjaga 

määratakse lõputöödega seonduvate toimingute (teemade valik ja kinnitamine, 

juhendamine, konsulteerimine ja retsenseerimine, lõputööde esitamine ja kaitsmine jne) 

tingimused ja kord. (ELA lõputöödega...., 2016) 

Lõputöö koostamisel on oluline järgida ELA kirjalike tööde vormistamise juhendit.  

3.1 Lõputöö eesmärk, õpiväljundid ja hindamine 

Lõputöö koostamise ja kaitsmise eesmärk on (ELA lõputöödega...., 2016): 

 kinnistada ja üldistada rakenduskõrghariduse õpingute ajal omandatud erialaseid 

teadmisi ja oskusi;  

 süvendada ja loovalt rakendada erialaseid teadmisi iseseisva uurimistöö kaudu; 

 arendada akadeemilise väitluse oskust. 

Lõputöö positiivsele hindele kaitsnud üliõpilane (ELA lõputöödega...., 2016): 

 rakendab iseseisvalt omandatud teadmisi konkreetsete teoreetiliste või praktiliste 

probleemide lahendamiseks; 

 püstitab uurimisülesande ning kasutades teoreetilisi materjale (ja olenevalt töö 

temaatikast teostades praktilisi ülesandeid) valib sobiva meetodi selle 

lahendamiseks; 
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 tunneb teadusliku teksti vormistamisnõudeid ja järgib neid töös; 

 tunneb erialast sõnavara ja oskab end väljendada nii suuliselt kui kirjalikult ja 

kaitsta oma seisukohti.  

 omab erialaseid teadmisi, mis on magistriõppesse õppimaasumise eelduseks.  

Kriteeriumid lõputöö hindamiseks (ELA lõputöödega...., 2016): 

1) töö sisu vastavus teemale ja püstitatud eesmärgile; 

2) materjali läbitöötatus, selle süstemaatiline ja loogiline esitus; 

3) algandmete autentsus ja kontrollitavus; 

4) aktuaalsus, praktiline vajadus ja töö tulemuste rakendatavus; 

5) argumentatsiooni veenvus ja ettepanekute põhjendatus; 

6) vormiline ja keeleline korrektsus. 

7) töö kaitsmine 

3.2 Lõputöö teema,  juhendaja ja konsultant 

Lõputöö teemad valmistatakse ette lennundusettevõtete ja eriala juhtivate õppejõudude 

ja/või akadeemilise struktuuri üksuste poolt, seejärel vaadatakse läbi rektori käskkirjaga 

määratud  komisjoni poolt. Üliõpilane võib lõputöö teema ise välja pakkuda, põhjendades 

selle vajalikkust. (ELA lõputöödega...., 2016) 

Lõputöö juhendajaks võivad olla (kõik juhtivad) kõrgkoolide õppejõud ning lennunduses 

töötavad ja vastavat kvalifikatsiooni omavad praktikud (ELA lõputöödega...., 2016). 

Reeglina  on juhendaja Eesti Lennuakadeemiast ja töö erialane konsultant 

lennundusettevõttest, aga võib olla ka vastupidi.  

3.3  Lõputöö struktuur 

Lõputöö struktuur ja järjestus on järgmine: 

 tiitelleht ja ülesande leht (vt lisa 1 ja lisa 2),  

 eessõna (pole kohustuslik), 

 resümee (võõrkeelne kokkuvõte , mis on üldjuhul inglise keeles), peab olema 

kontrollitud vastava võõrkeele filoloogi poolt, vt lisa 3), 
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 sisukord, (ilma lisade loeteluta ja sisukorrata, vormistada automaatselt), 

 kasutatud lühendid ja tähised (pole kohustuslik, vt kasutatud lühendid ja tähised 

lk 4), 

 kasutatud mõisted (pole kohustuslik), 

 sissejuhatus, 

 sisu peatükkidena, 

 kokkuvõte, 

 kasutatud materjalid , 

 lisad (vastavalt vajadusele). 

3.4 Lõputöö esitamine 

Lõputöö esitatakse ajakavas määratud kuupäevaks digitaalselt õppeosakonda.  

Lõputöö  elektrooniline lõputöö PDF fail  laaditakse  määratud kuupäevaks Moodle 

kursusele "Lõputööde esitamine"   või tuuakse õppeosakonda mälupulgal. 

Failinimi peab olema kujul: Eesnimi Perenimi - Töö pealkiri. pdf 

Lõputöö peab olema digiallkirjastatud autori, juhendaja ja erialaosakonna juhataja poolt: 

1) juhendaja ja üliõpilase allkirjad kinnitavad, et lõputöö on valmis; 

2) osakonna juhataja allkiri kinnitab lõputöö ülesande andmist. 

Kui üliõpilane lubab oma lõputööd edaspidi kasutada (laenutada jne), siis köidetakse töö 

viimaseks leheks "Lihtlitsents lõputöö reprodutseerimiseks ja lõputöö üldsusele 

kättesaadavaks tegemiseks" ( juhul kui töö on vaid asutusesiseseks kasutamiseks ja 

kaitsmine on kinnine, siis tuleb teha vastav taotlus õppeprorektorile). 

  

http://moodle.eava.ee/course/view.php?id=202


 
17 

 

4 KASUTATUD MATERJALID 

Eesti Lennuakadeemia lõputöödega seonduva tegevuse korraldamise eeskiri. (2016). 

Kasutamise kuupäev: 27. 11 2017. a., allikas Eesti Lennuakadeemia: 

http://media.voog.com/0000/0029/9428/files/Loputoode_eeskiri_14102016.pdf 

Esterm. (2017). Kasutamise kuupäev: 27. 11 2017. a., allikas Eesti Keele Instituut: 

http://termin.eki.ee/esterm/ 

Harris, R. (2001). The Plagiarism Handbook: Strategies for Preventing, Detecting, and 

Dealing with Plagiarism. Los Angeles: Pyrczk Publishing. 

Stacey, D. (2008). Aeronautical Radio Communication Systems and Networks. 

Chichester: John Wiley & Sons Ltd. 

Statistikaamet. (2017). Keskmine brutokuupalk. Kasutamise kuupäev: 27. 11 2017. a., 

allikas Eesti Statistika: https://www.stat.ee/stat-keskmine-brutokuupalk 

Tallinna Tehnikakõrgkooli kirjalike tööde vormistamise juhend. (2016). Kasutamise 

kuupäev: 27. 11 2017. a., allikas Tallinna Tehnikakõrgkool: 

http://www.tktk.ee/wp-content/uploads/Lisa-3_TTK-kirjalike-

t%C3%B6%C3%B6de-vormistamise-juhend-2016.pdf 

TTÜ Raamatukogu. (2017). Kirjalike tööde vormistamine. Kasutamise kuupäev: 27. 11 

2017. a., allikas TTÜ: https://www.ttu.ee/asutused/raamatukogu/tudengile-

4/kirjalike-toode-vormistamine/ 

Viitamine. (2013). Kasutamise kuupäev: 27. 11 2017. a., allikas Tallinna Tehnikaülikool: 

https://www.ttu.ee/public/r/raamatukogu/juhendid/viitamine.pdf 



 
18 

Üliõpilaste kirjalikud tööd. (2011). Kasutamise kuupäev: 27. 11 2017. a., allikas TÜ 

majandusteaduskond: 

https://www.mtk.ut.ee/sites/default/files/www_ut/kirjalike_toode_juhend_2011.

pdf 

 

 

  



 
19 

LISAD 

 

Lisa 1.  Tiitellehe  

Lisa 2.  Lõputöö ülesandelehe näidis 

Lisa 3.  Resümee näidis 

Lisa 4.  Lühikese kirjaliku töö vormistamine 

 



 
20 

Lisa 1. Tiitellehe näidis 

Eesti Lennuakadeemia 

Lennundusettevõtte käitamise õppekava 

 

 

 

 

 

 

 

 

Monika Kask 

REISIJATE TEENINDAMISE STANDARDITE 

RAKENDAMINE AS-is TALLINNA LENNUJAAM 

Lõputöö 

 

 

 

 Juhendaja:  Ivo Siimann,  PhD 

 Konsultant:  Erika Jaakson, MA 

  

 

 

Tartu 2012 



 
21 

Lisa 2. Lõputöö ülesandelehe näidis    

Kinnitan "……" ………….. 2012.a. 

 ..…………………………………… 

 (osakonna juhataja) 

 

LÕPUTÖÖ ÜLESANNE 

 

Teema: REISIJATE TEENINDAMISE STANDARDITE RAKENDAMINE AS-is 

TALLINNA LENNUJAAM 

 

Eesti Lennuakadeemia rektori käskkiri nr  6.1-4/26, 18. mai 2012.a. 

Töö esitamise tähtaeg: 21. mai 2012.a. 
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Töö lähteandmed ja tingimused: 
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Lõputöö vastab kehtivatele nõuetele. 
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 (allkiri) (kuupäev) 

Olen koostanud töö iseseisvalt. Kõik töö koostamisel kasutatud teiste autorite tööd, 

põhimõttelised seisukohad, kirjandusallikatest ja mujalt pärinevad andmed on viidatud. 

 

Üliõpilane:  Monika Kask ………………    ..……………… 

             (allkiri)        (kuupäev) 
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Lisa 3. Resümee näidis 

SUMMARY 

APPLYING AIR PASSENGER SERVICE STANDARDS TO 

TALLINN AIRPORT LTD 

Monika Kask 

The purpose of this diploma thesis is primarily to compose study material on passenger 

service standards for new customer service employees at Tallinn Airport. Customer 

service is nowadays an issue of upmost importance at…  



Kati Karukell 

3. kursus 

Lennundusettevõtte käitamine 

27.11.2017 

Lisa 4. Lühikese kirjaliku töö vormistamine 

Lorem ipsum 

„Lorem ipsum is a pseudo-Latin text used in web design, typography, layout, and 

printing in place of English to emphasise design elements over content. It's also called 

placeholder (or filler) text.“ [1] 

Lorem ipsum dolor sit amet, duo at stet elit definitionem, eu maiorum deterruisset eam. 

Utinam virtute sensibus has ne, in doctus periculis ius. Nostrum contentiones eos no, eum 

posse tritani legimus ut. No per modus sadipscing, lorem dissentiunt theophrastus et nam. 

Te graeci indoctum necessitatibus mel. [1] 

Ut eam partem disputationi, illud regione usu an. Ex partem aliquid nusquam nec. Te 

fuisset fierent evertitur eum. Eos movet detraxit salutandi cu, augue eruditi postulant ei 

nec. Pri nonumes scriptorem ad. Melius malorum ei eum, vidit clita deleniti et sea, cu 

libris suavitate consectetuer vix. [1] 

Id mei vide deseruisse. Mazim liberavisse cu vim, cum case viderer ut. Mea in malis 

periculis efficiantur, erat error aliquid nec ne. Odio animal accumsan an est. Te ius 

nonumes consulatu, eam ea case movet temporibus. [1] 

Porro detracto sit ut, id eos maluisset complectitur intellegebat, viris legimus ius in. Dico 

inciderint his ad. Has latine labitur an, ut scripta viderer eos. Id vivendum erroribus 

accusamus vis, te causae deseruisse sit. Ea labitur aliquid vim, iuvaret appareat percipitur 

vis no, ad sit vituperata honestatis consequuntur. Augue voluptatibus ne mel, lorem 

causae numquam ad his, has ad affert erroribus adversarium. [1] 

Alia harum contentiones pro ex, vitae nonumes invidunt ad eam. Vis mutat splendide ex, 

laudem nusquam platonem quo in, atqui conceptam cu duo. Vitae liberavisse te eam. Et 

deseruisse temporibus duo, eu ius ridens epicurei. [1] 

Et ius natum partiendo, sit veniam noster no. Vim putant appellantur ea, mei ex latine 

dignissim. Vis no prompta fuisset volutpat, quis ferri homero vix no. An vix doming 



 

 
24 

labores. Vis ad solet epicurei. Per te deserunt atomorum incorrupte. Tamquam tincidunt 

pro no. [1] 

Verear imperdiet moderatius vis ei. Ignota numquam vis no, qui singulis sententiae te. 

Graeci labores disputationi eam ut, mea ea duis invidunt euripidis. Et quo elit meis 

meliore, lorem ponderum ocurreret ut nam. Vocibus atomorum pro ad, ad inani erant 

delectus mei. [1] 

Nostrud evertitur omittantur pri cu, ea vitae quodsi aliquid nam. Eu vel justo nusquam 

oportere. Esse dissentias consequuntur nam te. Eu est torquatos persecuti scriptorem, alii 

disputationi has ei, esse debitis lucilius ei vis. [1] 

Munere constituto neglegentur ne eam, mel appetere accommodare ei. Ut primis oporteat 

consetetur vel, cu eam stet causae voluptatibus, eam in simul impetus vivendo. Sumo 

exerci graeci eam cu. Nec suscipit accusamus ad, te nec inani dissentias constituam, ex 

quo eruditi dolorem periculis. Enim tibique splendide mel ut. [1] 

Mei ut case libris audire, adhuc maluisset id sed. Cum eu amet constituto. Ad aliquam 

admodum deterruisset vim. Eu qui mollis deleniti, detraxit deseruisse dissentiunt per in, 

nam erat contentiones ea. No movet exerci his, usu nulla consetetur ad. [1] 

Kasutatud materjalid 

1. Lorem ipsum [http://generator.lorem-ipsum.info/] 27.11.2013 

http://generator.lorem-ipsum.info/

